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1 About this Guide 
This user guide provides both a description and operation procedures of the Microsemi’s software 
GUI (Graphical User Interface) utilized to demonstrate the Enhanced mode and Power over 
Ethernet+ (PoE+) mode.     

1.1 Audience 
This user guide is intended for qualified personnel, meaning operators and technicians who have a 
background in basic concepts of electronics and software. 

1.2 Organization 
This Guide is divided into several sections:  

Chapter 1 About this Guide describes the objectives audience organization and related 
documentation 

Chapter 2 Introduction describes the GUI’s main functions and the operation modes 
Chapter 3 Installation provides safety precautions, software requirements, hardware 

requirements and hardware setup 
Chapter 4 GUI Common Features describes how to Initialize the GUI and GUI's 

screen elements 

Chapter 5 Enhanced Mode Operation (EMO) describes the GUI’s Enhanced mode 
Operation, its various screens and the meaning of each screen’s button/indicator 

Chapter 6 PoE+ Mode Operation describes the GUI’s PoE+ mode operation, its various 
screens and the meaning of each screen’s button/indicator 

Chapter 7 Troubleshooting provides a useful troubleshooting guide and Program Download 
procedure 

 

1.3 9BEvaluation Board Kit 
The Evaluation Board Kit comes with the following items: 

 PoE Manager Enhanced mode installation CD 

 Aardvark-Evaluation board I2C adapter cable 
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2 Introduction 
Microsemi’s demonstration boards provide the designer with the environment needed to evaluate the 
performance and the implementation of the Enhanced and PoE+ modes.  

There are two operating modes: 

 Enhanced Mode, page 6 

 PoE+ Mode, page 8 

2.1 Enhanced Mode 
The Enhanced Mode configuration for PoE systems is divided into three main different systems: 

 PoE system based on PD69000 PoE controller and four PoE managers ICs 
(PD69012 or PD69008), as shown in Figure  2-1. PoE managers function as slaves 
to a PoE Controller. 

PD69012
#0

ESPI Bus:
- SCK
- CS
- MOSI
- MISO

UART/I2C 
 Isolation

Host
CPU

ESPI 

PD69012
#1

PD69008
#2

PD69008
#3

PD69000
PoE 

Controller

Reset Reset

 
Figure  2-1: Enhanced Mode Block Diagram – Utilizing PD69000 

 

 PoE system based on the PD63000 PoE controller and two PoE managers ICs 
(PD64012G/H or PD64004A/H), as shown in Figure  2-2. PoE managers function as slaves 
to a PoE Controller. 

 

MISO

SCK

MOSI
I/O Opto

Host
CPU

CS 0_ N
CS 1_ N

CS 0_ N
CS 1_ N

CS1
CS0

I2C or UART

SPI Bus

PD63000
PoE    

Controller

Pull-down
resistor

PD64012G/H 
(or 

PD64004A/H)
#00

PD64012G/H 
(or 

PD64004A/H)
#01

 
Figure  2-2: Enhanced Mode Block Diagram – Utilizing the PD63000 

 PoE system based on the PD69100 PoE controller and PoE managers IC (PD69108 or 
PD69104). 

PoE manager ICs automatically perform PoE operations, while PoE Controller performs power 
management and other tasks.  
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Host CPU communicates with PoE Controller via an isolated UART interface or I2C interface. 
PoE Controller is used to initialize, control and monitor each of the PoE managers ICs via an internal 
ESPI (69000 and 69100 systems) / SPI (63000 system) bus. 

In Enhanced mode, PoE Controller performs additional Power over Ethernet tasks, such as: 

 Legacy PDs detection  

 Enhanced power management algorithms 

 Port matrix control 

 Communication protocol translator 

2.1.1 PoE Manager ICs Types 
 IEEE802.3af standard ICs (AF ICs): PD64012/G/GH, PD64004A/AH, PD69012, 

PD69008, PD69104, and PD69108 

 IEEE802.3at standard (AT ICs): PD64012GH, PD64004AH, PD69012, PD69008, 
PD69104, and PD69108 

2.1.2 Enhanced Mode Feature Support 
The Enhanced Mode software supports the following features: 

 Supports up to 96 ports. 

 Real-time refresh rate (less than two-seconds intervals) of system and port 
measurements, including: 

o General power, voltage, and current measurements 

o Status (on, off, power management, overload) per port 

o Power consumption [W] per port 

o Current [mA] per port 

o Class per port (0-4) 

o Enable / disable per port 

 Automatic detection of connected devices 

 Supports 600mA current in AT mode 

 Displays GUI version and PoE Controller’s software version 

 Line Detection Algorithms 

o IEEE 802.3af 

o IEEE 802.3af + Pre Standard  

 System resetting (by a pushbutton) 

 Restoring default values (by a pushbutton) 

 Saving system settings (by a pushbutton) 

 Graphic display of port status from PoE Devices (port on, port off due to AC 
disconnect or due to overload) 

 Power budget 

 AF: Banks 1 to 7 

 AT: Banks 0 to 15  

 Advanced power management 
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 Setting Vmain limits 

 Defining maximum power per port 

 Defining interrupt Mask parameters and viewing interrupt statuses 

 Thermal emulation of the PD64012 and PD64004A and setting thermal limits 

 Enabling setting priority for all ports  

 Establishing logical/physical port relationship 

2.2 PoE+ Mode 
The switch host CPU communicates with PD33000B via an isolated I2C or UART bus (see 
Figure  2-3).  

PD64004
#00

PD64004
#01

MISO
SCKPoE

Controller

MOSI
I/O Opto

HOST
CPU

CS0_N

CS1_N

CS0_N

CS1_N

CS1
CS0

Pull Down

I2C or UART

SPI Comm.

 
Figure  2-3: PoE+ Mode Block Diagram  

In this mode of operation, PD64004s communicate with PD33000B PoE Controller via an SPI bus 
and are directly slaved to PD33000B. PoE Controller has additional Power over Ethernet features, 
such as: 

 Legacy PDs detection  

 PoE+ power management algorithms 

 Communication protocol translator 

The PoE+ mode software supports the following features: 

 Supports up to 8 ports (2 x PD64004A PoE Devices) 

 Automatic detection of devices connected (number of ports) 

 Display GUI version and firmware (PoE Controller) version 

 Real-time refresh rate (less than two-seconds intervals) of system and port 
measurements, including: 

o Current [mA] 

o Power consumption [W] 

o Class of PD (0-4) 

o Per port status (on, off, power management, overload)  

 Graphic display of port status from PoE devices (port on, port off due to AC 
disconnection mode or due to overload) 

 Thermal emulation of the two PD64004As; two temperature meters taking readings 
within the devices, with less than two seconds intervals 
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 System power management 

 System interrupt view and mask 
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3 Installation 
The following sections detail the installation process.  

 Application Requirements, page 10 

 Setting up the Hardware, page 10 

 Installing Software, page 11 

 Windows Settings, page 11 

3.1 Application Requirements 
To evaluate the board’s capabilities fully, Microsemi recommends using the software package 
provided with the Evaluation Board. The software enables communication from the PC to the 
Evaluation Board via RS-232 communication channel or I²C. For programming instructions, refer to 
Serial Communication Protocol User Guide, catalog number 06-0032-056. 

3.1.1 Required Hardware 
The minimum requirements for the PC are: 

 Pentium 166MHz (running on a Windows 98 or 2000 or XP platform) 

 64MB of RAM 

 16-bit color display (1024x768) 

 CD-ROM drive  

 40MB of free hard disk space 

3.1.2 Required Software 
Microsoft .NET Framework Version 2.0 Redistributable Package must be installed on the PC. 

 For Microsoft .NET Framework Version 2.0 Redistributable Package (x86): 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-
AAB15C5E04F5&displaylang=en 

 For Microsoft .NET Framework Version 2.0 Redistributable Package (x64): 

http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-
40E78D788B00&displaylang=en 

3.2 Setting up the Hardware  
1.  Turn off power supply. 

2.  Interconnect equipment as shown in Figure  3-1.  

Power supply should deliver 48 volts (nominal) / 20 amps (maximum). PC -Evaluation board I2C 
adapter cable comes with the kit. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-40E78D788B00&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-40E78D788B00&displaylang=en�
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Figure  3-1: Hardware Setup 

3.3 14BInstalling Software  
Refer to Figure  3-2.  
1.  Insert CD provided with the kit into CD drive. 

2.  Uninstall the previous GUI version (if exists). 

3.  Run Setup.exe. 

 
Figure  3-2: Setup Wizard 

4.  Click Next, Install, and Finish sequentially. 

The installation procedure is complete and the GUI is installed. 

3.4 15BWindows Settings 
View the GUI by setting DPI to normal resolution (96 DPI). 
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4 GUI Common Features 
The following sections describe: 

 Initializing the GUI 

 GUI screen elements 

4.1 Initializing the GUI 
1.  Adjust the power supply for 48 volts and apply power to the connected Evaluation Board.  

2.  On the desktop, click    

The Parameters Initialization screen appears, followed by the main screen, with the status bar 
displaying ‘"I²C" + Rate or "UART" + Com number' and ‘Online’ at the bottom of the screen. Kind 
of main screen that appears depends on the mode being used.  

 
Figure  4-1: Startup Screen 

If communication port operation fails, or the user wishes to modify the Communication link 
parameters manually, (refer to Modifying the Communication Parameters, page 13) the 
Communication dialog box appears (Figure  4-2). In this dialogue box, you can set the connected 
COM port and I2C parameters. 

 
 

Figure  4-2: Communication Dialog Box 
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4.2 GUI Common Elements 
There are a series of buttons and indicators on each screen. The following sections detail their 
functions. 

4.3 Connecting to the Board  

 Click  to connect Host computer to evaluation board. GUI software is now 
active.  

 Click  to disconnect Host computer from evaluation board. GUI software is 
disabled.  

4.4 Modifying the Communication Parameters 
The Communication dialog box (Figure  4-2) enables modifying the default communication 
parameters.   

1.  Click .  

The dialog box opens.  

2.  Edit the parameters as required. 

3.  Click Connect. 

The changes are automatically saved and the dialog box closes.  

4.5 Main Screen Indicators 
 Number of Ports: This indicator displays the total number of ports detected by the 

GUI software. 

 Communication Indicator : This indicator blinks when the PC communicates 
properly in both directions (Tx and Rx). The refresh rate is between 1 to 2 seconds. 

4.6 Menu Options 
The GUI contains the following menu options. 

4.6.1 Exiting the Program 
 Select File > Exit. 

4.6.2 Developer Status 

Figure  4-3 displays the Developer View dialogue box for logging in the developer mode.  
Note:  
Only authorized Microsemi personnel can access this mode. 

 
Figure  4-3: Developer Login Dialogue Box 
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4.6.3 Showing the Status Number 
The status number provides detailed information regarding the port status. For more information 
regarding the port status, refer to PD63000 & PD69000/G Serial Communication Protocol User 
Guide 06-0032-056. 

 Select Setup > Show status number.  

An additional field appears, showing a number representing the status description. 

 
4.6.4 Viewing the Demo Mode 
If you do not have the required hardware to test the evaluation board, the Demo mode enables you 
to view GUI screens. All functions are disabled. 

 To enter the Demo mode, select Help > Demo Mode. 

 To exit the Demo mode, select Help > Demo Mode. 

4.6.5 Viewing the Application Version 
To view the application version, select Help > About. 

 
Figure  4-4: About Dialogue Box 
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5 Enhanced Mode Operation (EMO) 
This chapter provides a detailed description of the Enhanced Mode software features. 

The Enhanced Mode software contains the following products: PD63000, PD33000, 
PD63000_HighPower, PD62000, PD69000, PoE_API , PD69000_HighPower, PD69002, 
CPSS_PoE_API , PD69100.  

Each product is automatically identified during GUI startup according to the Product number field. 

 

 
Figure  5-1: PoE Manager Enhanced Mode Window, Ports Tab (EMO) 

The Ports tab (of the PoE Manager Enhanced Mode window) includes the following elements: 

 Main Menu Tabs: Used to select the following functions: 

o Ports: Displays ports' real-time monitoring, product number, GUI 
version, allows setting of the detection method (AF/AT or AF/AT +Pre 
Standard) and selection of the alternative option ('A' or 'B'). Refer to The 
Ports Tab (EMO), page 17. 

o Power Management: Sets power budget, power banks, valid input 
voltage and presents real time measurements. Refer to The Power 
Management Tab (EMO), page 20. 
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o Interrupt: Displays interrupt related information and masks. Refer to 



  PoE Enhanced and PoE+ Mode GUI User Guide 
 

 

Company Confidential 

 

Copyright © 2012  Microsemi  Page 17 
Rev. 1.6, 17-Jun-12 Analog Mixed Signal Group 

1 Enterprise, Aliso Viejo, CA 92656, USA; Within the USA: (800) 713-4113, Outside the USA: (949) 221-7100 Fax: (949) 756-0308 

The Interrupt Tab (EMO), page 21. 

o IC Status: Displays the current PD devices temperature, enables 
temperature alarm limit setting and selection of AT mode. Current HW 
version is also displayed. Refer to The IC Status Tab (EMO), page 23. 

o Matrix: Displays Logical to Physical port associations. Refer to The 
Matrix Tab (EMO), page 25 

o PPL: Used for setting port power limit for all ports. Refer to The PPL 
(Port Power Limit) Tab (EMO), page 27. 

o TPPL: Used for setting the Temporary Port Power Limit for all ports. 
Refer to The TPPL (Temporary Port Power Limit) Tab (EMO), page 28 

o Priority: Used for priority setting for all ports. Refer to The Priority Tab 
(EMO), page 29. 

 LEDs: Indicates the ports status  

 Enable Checkboxes Used for enabling port/s  

 Power, Current, Class Measurements Fields: Displays measurements taken on the 
input power line such as voltage, current and calculated power  

For detailed information on the Enhanced Mode's buttons, indicators, and combo-boxes, refer to GUI 
Common Features on page 12. 

 

5.1 The Ports Tab (EMO) 
The Ports tab (Figure  5-1) has several functions:  

 Displays: 

o Port number 

o Status information of each port 

o Power and current information 

o Port class 

o The software version 

o System power statistics  

 Enables/disables the port 

 Enables each device's AT operation mode 

 Sets the power budget 

 Sets the line detection method 

 Resets the system, saves system parameters or restores the default parameters 

 Sets the backoff time 

5.1.1 Enhanced Mode Port Status Indicators 
The following buttons display information on each port: 

 : Used to navigate between ports 0-12, 13-24, 25-36, and 37-48. 

 : Enables you to display the status of the next four ports (+4) / previous 
four ports (-4). 
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 Ports: Ports number: The ports are physically defined from 1 to 12, but their logical 
designation is from ‘0’ to ‘11’, depending on the number of PoE Managers in the 
system.  

 LED: This multi-color indicator indicates port status: 

o Dark green: Port off 

o Light green: Port on 

o Yellow : Port overloaded or shorted  

o Yellow blinking : Port under power management  

 Status: Indicates actual port status number and its description. Statuses are: 

o UnDef: Port is off, non-existing port number 

o ON: Port is on, valid resistor/capacitor detected 

o ON-Hi: High power port is ON 

o OFF: Port is off, user setting  

o INIT- Port is off, detection is in process 

o UDL: Port is off, Underload state 

o OVL: Port is off, Overload state 

o P.M.: Power Management function shuts down port due to lack of 
power. Port shuts down or remains off. 

o SHORT: Port is off, short condition 

o ERR: Port is off, internal hardware fault 

o VOUT: Port is off, main supply voltage is high/low 

o TEMP: Port is off, over temperature at the port. 

o OVPWR: PoE IC Over Power 

o OTHER: Unknown status  

For more information, refer to User Guide-PD33000B Serial Communication Protocol, 
catalog number 06-0031-056, table 1: Actual Port Status 

 Power: Power consumed by each port. 

 Current: Current consumed by each port. 

 Class: The PSE (PoE device) determines the PD class during the interrogation 
stage. The class is displayed as a number from 0 to 4. 

 : Displays the GUI version, product version, PoE controller’s 
software version, and parameters version. 

 : Displays the system power statistics (refer to  5.1.4Setting the 
Power Budget on page 19): 

o Vmain: Main input voltage 
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o Imain: Total input current 

o Power: Total power consumption 

5.1.2 Enabling/Disabling Ports 
To enable/disable a port: 

 Check/uncheck the required checkbox, either individually or all at once by checking 
the All checkbox. 

5.1.3 Enabling AT Mode 
To set the AT or AF operation mode: 

 Check the AT Enable box to enable AT operation. 

 Leave the AT Enable box unchecked to enable AF operation. 

5.1.4 Setting the Power Budget 
In this text box, you can set the system power limit. Power limit must be between 37 and 2000 watts. 

To set the power limit: 

1.  In the Power Budget text box, type the required number of watts. 

2.  Click Set Power.  
Note:  
The GUI enables setting the power budget from 0 to 65535 watts. In cases where the power is out of 
range, the PoE CPU will reply with an error message. 

In addition, the GUI displays the following specifications: 

 Power Budget: Displays the system power budget. 
 Vmain Range: Displays the main input voltage ranges. The values are determined in 

the Power Management tab, page 20. 

5.1.5 49BSetting the Line Detection Method 
You can set the Line Detection Method to one of the following: 

 AF/AT (this method does not detect legacy devices). 

 AF/AT + Pre Standard (Capacitor Detection) (detects legacy devices) 

5.1.6 50BSetting the Backoff Time 
Power is carried over the cabling using two techniques: Alternative A and Alternative B 

Alternative A implements a simplex method for delivering power to the end device. Power is carried 
on the same conductors as data. 

Alternative B carries power over spare wire pairs in the cable. 

Select one of two valid four-wire connections to power the PSE: 

 Alternative A: Power the PSE over data lines (1, 2 and 3, 6) 

 Alternative B: Power the PSE over spare lines (4, 5 and 7, 8) 

5.1.7 51BSetting System Parameters 
The GUI Software provides three options for setting the system parameters: 

 Save: Saves the current configuration parameters to the PoE Controller’s non-
volatile memory. 

 Restore: Restores the factory defaults parameters and restarts the GUI operation. 
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 Reset: Resets the PoE Controller and the PoE devices and restarts the GUI 
operation. 

5.2 The Power Management Tab (EMO) 
The Power Management tab enables: 

 Setting the required output power and parameters 

 Viewing Real Time Measurements and online consumed power  

 Setting of the Power management Mode 

To access the Power Management tab:  

 On the PoE Manager Enhanced Mode window, click the Power Management tab. 
The following screen appears (Figure  5-2): 

 
Figure  5-2: PoE Manager Enhanced Mode Window, Power Management Tab (EMO) 

5.2.1 Setting the Power parameters 
The above table sets each bank's:  

- Power budget 

- Guard Band (The Guard Band is the range in which the evaluation board will not connect to 
additional ports) 
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- Vmax (upper input voltage limit)  

- Vmin (lower input voltage limit).  

To set power banks parameters click the "Set Power, GB and Vmain limits" button. 

To get power banks parameters click the "Get All Parameters" button. 

5.2.2 Real Time Measurements Field 
These read only fields display the real-time current, voltage, and power.  
 Vmain: Actual input line voltage 
 Imain: Total current consumption 
 Mesured Power: Total measured used power (Vmain x Imain) 

 Calculated Power: This read only field displays the sum power of all ports, allocated 
by the IEEE standard 802.3af-2003, or actually consumed according to Calculated 
Power Management mode 

5.2.3 54BProviding Extra Power 
The PoE IC can provide extra power to the ports (Available in advanced mode). 

To provide extra power mark the AT extra power checkbox.  

5.2.4 55BSetting the Power Mode 
Setting the power mode for the ports consists of 3 steps: 

1. PM-1: How system power is being calculated (Summed). 

o 0 - Full Dynamics (Consumption) 

o 1 - Classes 1 to 3 = Class power, classes 0,4 = Dynamic 

o 2 - Classes 0 to 3 = Class power, class 4 = Dynamic 

o 3 - Classes 1 to 4 = Class power, class 0 = Dynamic 

o 4 - Classes 0 to 4 = Class power. 

2. PM-2: Port Power Limit. 

o 0 - Table set by the user (PPL) 

o 1 - Class Limit 

o 2 - Max (AT/AF flag) 

3. PM-3: Start up conditions: The port will not start up in case that detected class 
power is higher than the predefined. 

o 0 - No Condition 

o 1 - Condition on Classes 1 to 3  

o 2 - Condition on Classes 0 to 3  

o 3 - Condition on Classes 1 to 4  

o 4 - Condition on Classes 0 to 4 

 

.  



  PoE Enhanced and PoE+ Mode GUI User Guide 
 

 

Company Confidential 

 

Copyright © 2012  Microsemi  Page 22 
Rev. 1.6, 17-Jun-12 Analog Mixed Signal Group 

1 Enterprise, Aliso Viejo, CA 92656, USA; Within the USA: (800) 713-4113, Outside the USA: (949) 221-7100 Fax: (949) 756-0308 

5.3 The Interrupt Tab (EMO)  
The Interrupt tab enables definition of interrupt masks and viewing of interrupt statuses. 

To access the Interrupt tab:  

 On the PoE Manager Enhanced Mode window, click the Interrupt tab. The following 
screen appears (Figure  5-3): 

 
Figure  5-3: PoE Manager Enhanced Mode Window, Interrupt Tab (EMO) 

The Interrupt tab displays the following information: 

 HW IRQ: This number indicates the event bid. 

 Interrupt Reg: This field describes each Interrupt event. 

 System: A green LED indicates that an interrupt event has occurred. 

 ICs Interrupt Indication LEDs: Indicates the specific PoE device that caused the 
event (bits 8 to 10). A red LED means IC fault, while a green LED means a valid IC. 

5.3.1 Displaying an Event 
To display the events: 

 Click Get Interrupt.   

To mask events: 
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1.  Click the Mask checkbox of the required event. 

2.  Click Get Interrupt Events. 

The tab displays the interrupt status.   

 Green LED: No event occurred  

 Red LED: An event occurred 

Upon LEDs refreshment, the CPU zeros the event register. 

5.4 The IC Status Tab (EMO) 
The IC Status tab displays the Integrated Circuit (IC) temperature. Each PoE device incorporates two 
or four temperature sensors, measuring the IC's temperature. In addition, the PoE devices have an 
over-temperature limit setting, which enables the Host CPU to receive relevant over-temperature 
feedback (refer to Setting the Temperature Limit, page 25).  

The tab presents AT mode checkboxes allowing the user to set the chip mode to AT when checked, 
or to AF mode when unchecked. In cases where the hardware is not an AT compliant, the program 
refuses any attempt to set the chip to AT. 

To access the IC Status tab: 

On the PoE Manager Enhanced Mode window, click the IC Status tab. The following screen 
appears (Figure  5-4): 
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Figure  5-4: PoE Manager Enhanced Mode Window, IC Status Tab (EMO) 

5.4.1 IC Status Display 
The IC Status tab displays the following information: 

 IC number and status: Status Display displays the PoE device number and current 
status: 

o None: No PoE device detected 

o OK: Expected PoE device detection  

o Volatile: Unexpected PoE detection  

o New: Unexpected PoE detection (1) 

o Error: Fail/Missing PoE device 

o Different: Different PoE device was detected  

 Temperature telemetry: Per IC temperature sensors display the relevant IC 
temperature (average of the two or four sensors). The temperature font color 
corresponds to the color of the temperature bar. 

 Type: PoE device’s number of ports  
 HW version: PoE device current hardware version 
 AT mode: Device AT operation request and status:  
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o Checked: AT operation 

o Unchecked: AF operation 

 Temperature bar: A color legend that represents the temperature value 
corresponding to the temperature font color. 

5.4.2 58BSetting the Temperature Limit 
To set the temperature limit of an individual IC device, in the Temp. Limit field type the required 
temperature (in Celsius). 

To set the temperature limit of all IC devices:  

1.  Under All IC's, click Set Temperature Limit. 

2.  Click Save & Reset. 

5.4.3 59BDisplaying the Current Temperature Limits 
This button retrieves the temperature limit settings from the CPU. 

5.5 26BThe Matrix Tab (EMO) 
The Matrix tab displays the system’s logical ports configuration 

To access the Matrix tab:  

 On the PoE Manager Enhanced Mode window, click the Matrix tab. The following 
screen appears (Figure  5-5): 
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Figure  5-5: PoE Manager Enhanced Mode Window, Matrix Tab (EMO) 

5.5.1 Viewing the Current Physical – Logical Port Matrix 
Click Get. The physical matrix appears.  

5.5.2 Defining the Physical – Logical Port Matrix 
In cases where the physical definition of a port (or ports) does not correspond with the logical 
definition, you can manually map the correspondence. 

To define the correspondence between a physical port and any logical port: 

1.  In the physical port's drop down menu, select the port number corresponding to the logical port. 

2.  Repeat for any port that requires definition. 

3.  Click Set. 

The physical port is defined. 
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5.5.3 Setting the Default Matrix 
You can define the physical/logical port correspondence as 1:1. For example, Logical port 1 
corresponds to Physical port 1; Logical port 12 corresponds to Physical Port 12 and so on. 

1.  Click Default Matrix.  

2.  Click Save.  

Physical ports are defined.  
 

5.6 The PPL (Port Power Limit) Tab (EMO) 
The PPL (Port Power Limit) tab enables to set the power limit of each port. PPL is the maximum 
power per single port. If a port exceeds its power limit, the PoE system shuts that port down. 

To access the PPL tab:  

 On the PoE Manager Enhanced Mode window, click the PPL tab. The following 
screen appears (Figure  5-6): 

 

Figure  5-6: PoE Manager Enhanced Mode Window, PPL Tab (EMO) 

5.6.1 Viewing the Current Power Limits 
Click Get. The tab displays the current power limits as set by the PoE Controller.  
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5.6.2 Setting the Port Power Limit 
1.  In the required field(s), type the power limit. 

2.  Click Set. 

The power limits are set.  

5.6.3 Setting a Uniform Power Limit 
You can set a uniform port power limit. 

1.  In the Apply to All field, type in the required power limit. 

2.  Click Apply to All. 

The power limit is set. 

5.7 The TPPL (Temporary Port Power Limit) Tab (EMO) 
The TPPL (Temporary Port Power Limit ) tab enables to set a temporary power limit for each port. 
The TPPL is the maximum power value per one single active port. This value will be the port’s new 
power limit only when the port is still ‘on’. When port is turned off, the maximum power for a specific 
port returns to PPL. If a port exceeds its power limit, the PoE system shuts down the appropriate 
port. 

To access the TPPL tab:  

On the PoE Manager Enhanced Mode window, click the TPPL tab. The following screen appears 
(Figure  5-7): 
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Figure  5-7: PoE Manager Enhanced Mode Window, TPPL Tab (EMO) 

5.7.1 Viewing the Current Power Limits 
Click Get. The tab displays the current power limits as set by the PoE Controller.  

5.7.2 Setting the Port Power Limit 
1.  In the required field(s), type the power limit. 

2.  Click Set. 

The power limits are set.  

5.7.3 Setting a Uniform Power Limit 
You can set a uniform port power limit. 

1.  In the Apply to All field, type in the required power limit. 

2.  Click Apply to All.  

The power limit is set.  

5.8 The Priority Tab (EMO) 
The Priority tab enables setting or displaying the ports' priorities. The priority levels determine which 
ports receive power in case the demand is greater than the supply. There are three priority levels: 
Critical, High, and Low.  
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To access the Enhanced Mode Port Priority tab:  

 On the PoE Manager Enhanced Mode window click the Priority tab. The following 
screen appears (Figure  5-8): 

 
Figure  5-8: PoE Manager Enhanced Mode Window, Priority Tab (EMO) 

5.8.1 Viewing the Current Power Limits 
Click Get. The tab displays the current priority level as set by the PoE Controller.  

5.8.2 Setting the Port Power Limit 
1.  From the drop down list, select the priority level for each port. 

2.  Click Set. 

The priority levels are set.  

5.8.3 Setting a Uniform Power Limit 
You can set a uniform priority level. 

1.  From the Apply to All list, select the required level. 

2.  Click Apply to All.  

The uniform priority level is set.  
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6 PoE+ Mode Operation 
This chapter provides a detailed description of the PoE+ mode. 

 
Figure  6-1: PoE Manager Enhanced Mode Window, Ports Tab (PoE+) 

Figure  6-1 includes the following elements: 

 Main menu tabs: Used for selecting the following screens: 

o Ports: Displays real-time monitoring of the system and ports. Refer to 
The Ports Tab, page 32.  

o Power Management: Sets power budget, power banks, valid input 
voltage and presents real time measurements. Refer to The Power 
Management Tab, page 33. 

o Interrupt: Displays interrupt related information and mask. Refer to The 
Interrupt Tab, page 35.  

o IC Status: Displays the current PD64012 devices temperature and 
enables the temperature alarm limit setting. Refer to The IC Status Tab, 
page 37.  

o Port Power Limit: Maximum output power per port. Refer to The PPL 
(Port Power Limit) Tab, page 38.  

o Priority: Enables priority setting for all ports, individually or all-at-once. 
Refer to The Priority Tab, page 39. 

 Port status indicators: Indicates ports' status.  
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 Port enable checkboxes: Used for enabling port/s,  

 Power, current, class measurements field: Displays measurements taken on the 
input power line, such as voltage, current and calculated power. 

For detailed information regarding PoE+ Mode's main screen buttons, indicators and combo-boxes, 
refer to GUI Common Features, page 12. 

6.1 The Ports Tab (PoE+) 
The Port tab (Figure  6-1): 

 Displays system information  

 Enables setting the power budget. 

6.1.1 PoE+ Mode Port Status Indicators  
The following buttons display information on each port: 

 Ports: The port number, 1 to 8. 

 LED: Graphical LED, displaying the actual status of the relevant port: 

o Dark green: Port off 

o Light green: Port on 

o Yellow : Port overloaded or shorted  

o Yellow blinking : Port under power management  

 Status: Indicates the actual port status. Statuses are:  

o UnDef: Port is off; non-existing port number 

o ON: Port is on; valid resistor/capacitor detected 

o ON-Hi: High power port is ON 

o OFF: Port is off; user setting  

o INIT- Port is off; detection is in process 

o UDL: Port is off; Underload state 

o OVL: Port is off; Overload state 

o P.M.: Power Management function shuts down port, due to lack of 
power. Port shuts down or remains off. 

o SHORT: Port is off; short condition 

o ERR: Port is off; internal hardware fault 

o VOUT: Port is off; main supply voltage is high/low 

o TEMP: Port is off; over temperature at the port. 

o OVPWR: PoE IC Over Power 

o OTHER: Unknown status 

For more information, refer to User Guide-PD33000B Serial Communication Protocol, 
catalog number 06-0031-056, table 1: Actual Port Status 

 Power [W]: Power consumed by each port. 

 Current [mA]: Current consumed by each port. 

 Class: Displays each port's class, in accordance with IEEE 802.3af standard. 
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6.1.2 Enabling/Disabling Ports 
To enable/disable a port: 

 Check/uncheck the required checkbox(es) individually, or all at once by checking the 
All checkbox. 

6.1.3 Resetting the PoE Controller 
Click Reset. The PoE Controller is reset. All parameters are set to their defaults. 

6.1.4 Setting the Power Budget 
In this text box, you can set system power limit. Power limit must be between 22 and 160 watts.  

1.  In the Set Power field, type the required number of watts. 

2.  Click Set Power. 

The system power budget is set. In addition, the screen displays the following specifications: 

 Power Budget: Displays the current power budget. 

 Vmain Range: Displays the main input voltage ranges.  

6.1.5 Selecting the Line Detection Method 
You can set the line detection method to: 

 AF 

 AF + Pre Standard 

6.2 The Power Management Tab (PoE+) 
The Power Management tab enables: 

 Setting the required output power  

 Viewing Real Time Measurements and online consumed power  

 Setting off the Calculated Power Mode 

To access the Power Management tab:  

On the PoE Manager Enhanced Mode window, click Power Management tab. The following screen 
appears (Figure  6-2): 
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Figure  6-2: PoE Manager Enhanced Mode Window, Power Management Tab (PoE+) 

6.2.1 Viewing the Current Parameters 
To view the current parameters, click Get All Parameters. The parameters appear on the screen.  

6.2.2 Setting the Limits Definition 

These fields determine the minimum and maximum voltage settings shown in Figure  6-1. 

To set the voltage limits: 

1.  In the Vmax field, type the upper input voltage limit. 

2.  In the Vmin field, type the lower input voltage limit. 

3.  Click Set Vmain Limits. 

The Guard Band is a 19-watt constant limit. Within this range no additional ports are connected.  

6.2.3 Setting the Power Mode 
Setting the power mode for the ports consists of two steps: 

 Selecting the Power Management Mode 

 Selecting the Port Power Limit Mode 

1.  Under Power Management Mode, select: 

 Dynamic Power Management: Based on actual used power (enables Predefined or 
Max mode) or 
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 Static Management: Set by the PD classification and according to the IEEE 802.3af 
standard (enables Max or Class modes) 

2.  Under the Port Power Management Limit Mode, select the required mode. 

 Predefined: A user defined limit 

 Max: If a PD’s consumed power exceeds full power it is disconnected 

 Class: If a PD’s consumed power exceeds its class predefined power, it is 
disconnected 

The configuration is saved to the PoE Controller’s non-volatile memory. 

6.2.4 Setting the Board LED Blink Rate 
The board blink rate sets the required LED-blinking rate in the power management state.  

Click the required radio box. The setting is saved. 

6.2.5 Real Time Measurements Field 
These read only fields display the real-time current, voltage, and power.  
 Vmain: Actual input line voltage 
 Imain: Total current consumption 
 Power: Total power used (Vmain x Imain) 

6.2.6 82BCalculated Power Field 
This read only field displays the sum power of all ports allocated by the IEEE standard 802.3af-2003, 
or actually consumed according to Calculated Power Management Mode. 

6.3 32BThe Interrupt Tab (PoE+) 
The Interrupt tab enables definition of interrupt masks and viewing of interrupt statuses. 

To access the Interrupt tab:  

 On the PoE Manager Enhanced Mode window, click the Interrupt tab. The following 
screen appears (Figure  6-3): 
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Figure  6-3: PoE+ PoE Manager Enhanced Mode Window, Interrupt Tab (PoE+) 

The Interrupt tab displays the following information: 

 HW IRQ: This number indicates the event bid. 

 Interrupt Reg: This field describes each Interrupt event. 

 System: A green LED indicates that an interrupt event has occurred. 

 ICs Interrupt Indication LEDs: Indicates the specific PoE device that caused the 
event (bits 8 to 10).  A red LED means IC fault, while a green LED means a valid IC. 

6.3.1 Displaying Events 
To display the events, click Get Interrupt. 

To mask events: 

1.  Click the Mask checkbox of the required event. 

2.  Click Get Interrupt Events.   

The screen displays the interrupt status.   

 Green LED: No event occurred  

 Red LED: An event occurred 

Upon LEDs refreshment, the CPU zeros the event register. 
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6.4 The IC Status Tab (PoE+) 
The IC Status tab displays the chip's temperature. Each PoE device incorporates two sensors, 
measuring the junction temperature. In addition, the PoE devices include an over-temperature limit 
setting to allow the Host CPU to receive a relevant over-temperature indication. 

To access the IC Status tab: 

 On the PoE Manager Enhanced Mode window, click IC Status tab. The 
followingscreen appears (Figure  6-4).: 

 
Figure  6-4: PoE Manager Enhanced Mode Window, IC Status Tab (PoE+) 

6.4.1 IC Status Display 
The IC Status tab displays the following information: 

 IC Number and Status: Status display displaying the PoE device number and 
current status: 

o OK: Expected PoE device detection  

o ERR: Fail/missing PoE device 

 Temperature Telemetry: Per IC temperature sensors display the relevant IC 
average temperature (average of the two or four sensors). The temperature font 
changes its color in accordance with the actual temperature.  

 Type: PoE device’s number of ports  
 HW version: PoE device current hardware version 
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 Temperature Bar: A color legend that represents the temperature value in 
correspondence with the temperature font color. 

6.4.2 Setting the Temperature Limit 
To set the temperature limit of an individual IC device, in the Temp. Limit field, type the required 
temperature (in Celsius). 

To set the temperature limit of all IC devices, under All IC's, click Set Temperature Limit. 

6.4.3 Displaying the Current Temperature Limit 
You can retrieve the current temperature limits from memory. 

Click Get Temperature Limit. The temperature limits appears in the Temp. Limit fields 

6.5  The PPL (Port Power Limit) Tab (PoE+) 
The PPL (Port Power Limit) tab enables to set the power limit of each port. 

To access the PPL tab: 

 On the PoE Manager Enhanced Mode window I, click the PPL tab. The following 
screen appears (Figure  6-5): 

 
Figure  6-5: PoE Manager Enhanced Mode Window, PPL Tab (PoE+) 

6.5.1 Viewing the Current Power Limits 
Click Get. The tab displays the current power limits as set by the PoE Controller.  
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6.5.2 Setting the Port Power Limit 
1.  In the required field(s), type the power limit. 

2.  Click Set. 

The power limits are set.  

6.5.3 Setting a Uniform Power Limit 
You can set a uniform port power limit. 

1.  In the Apply to All field, type in the required power limit. 

2.  Click Apply to All. 

A uniform power limit is set.  
  

6.6 The Priority Tab (PoE+) 
The Priority tab enables setting or displaying the ports' priorities. The priority levels determine which 
ports receive power in case the demand is greater than the supply. There are three priority levels: 
Critical, High, and Low.  

To access the Priority Tab:  

 On the PoE Manager Enhanced Mode window, click the Priority tab. The following 
screen appears (Figure  6-6): 

 
Figure  6-6: PoE Manager Enhanced Mode Window, Priority Tab (PoE+) 
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6.6.1 Viewing the Current Power Limits 
Click Get. The tab displays the current priority level as set by the PoE Controller.  

6.6.2 Setting the Port Power Limit 
1.  From the drop down list, select the priority level for each port. 

2.  Click Set. 

The priority levels are set.  

6.6.3 Setting a Uniform Power Limit 
You can set a uniform priority level. 

1.  From the Apply to All list, select the required level. 

2.  Click Apply to All.  

The uniform priority level is set.  
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7 Troubleshooting  
Table 7-1 provides a troubleshooting guide.  

The scenarios described in the table are simple and do not take into account human errors or 
multiple failures. Carry out corrective actions in a sequential manner.  

For problems that are not resolved, refer to your nearest Microsemi Customer Support, as indicated 
on this User’s Manual rear cover. 

Table 7-1: Evaluation Boards Troubleshooting Guide 
 

Symptom Corrective Action 

Evaluation Board does 
not power up; D4 
indicator (Vmain On) 
does not illuminate. 

1.  Verify that power is applied to the 48 VDC cable. 
2.  Verify that correct polarity is supplied to the Board. 
3.  Verify that the power cable at J1 is well secured. 

UART communication 
with the Board fails to 
start  

1.  Ensure that there is a proper cable connection to J26 and to the 
other cable end. 
2.  Verify that a standard null modem RS-232 cable is used. 
3.  Verify that J14 is in position ‘3’. 
4.  Verify that jumpers J12 and J13 are set to position ‘1’. 
5.  Verify that the Board is set to Enhanced mode (switches SW2 thru 
SW5). 
6.  Depress Reset switch – SW1. 

I2C communication with 
the Board fails to start  

1.  Ensure that Aardvark-Evaluation board I2C Adapting cable is 
properly connected. 
2.  Verify AArdvark driver is properly connected to PC's USB cable. 
3.  Verify board is set to Auto mode. 
4.  Depress Reset switch – SW1. 

A PD connected to the 
Board fails to operate 

1.  Verify PD is IEEE 802.3af-compliant and designed for PoE via the 
spare pair. 
2.  Replace the Ethernet cable. 
3.  Try to reconnect the PD to another port. If it is powered, then there is 
probably a faulty port or the RJ-45 connector in the gang assembly is 
defective. 

PD powers up, but 
there is no data link 

This is normal behavior since Evaluation Board is designed for 
demonstration purposes and does not support data. 
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